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 Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0  

 Αρχικά 

 Ανοίγουµε το Minitab κάνοντας διπλό κλικ στο εικονίδιο  Minitab στην 

οθόνη ή πηγαίνοντας στο Start/Statistical Packages/Minitab 12.  

 

 
 

Όταν το πρόγραµµα “φορτώσει”, εµφανίζεται στη οθόνη το βασικό παράθυρο 

του Minitab  

 Παράθυρο του Minitab 

 
 

Toolbar 
Session window 

Status bar 

Data window 

Info window History window

Menu bar 
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Status bar και Toolbar 

Το Status bar παρουσιάζει χρήσιµα µηνύµατα που εξηγούν την τρέχουσα 

στιγµή ποιό στοιχείο έχει επιλεγεί από το Menu bar ή ποιό εργαλείο έχει 

επιλεγεί από τη ράβδο εργαλείων. 

Παρατηρούµε την αλλαγή κειµένου επιλέγοντας µε το δείκτη του ποντικιού για 

παράδειγµα τη θέση Stat του Menu bar και οποιαδήποτε από τις υπο-

καρτέλες που εµφανίζονται ή κατά τον ίδιο τρόπο επιλέγοντας οποιοδήποτε 

εικονίδιο από το Tool bar. 

 

Το toolbar βρίσκεται ακριβώς κάτω από το menu bar και εµφανίζει εικονίδια 

χρήσιµα για λειτουργίες που χρησιµοποιούνται συχνά.  

Για να µια σύντοµη περιγραφή του κάθε εικονιδίου αρκεί να µετακινήσουµε το 

δείκτη του ποντικιού πάνω σε κάθε εικονίδιο. 

Menu bar 

Το Menu bar περιέχει εννέα κυλιόµενα µενού, µέσω των οποίων µπορούµε 

να εκτελέσούµε µία εντολή ως εξής: 

 

1. Κάνουµε κλικ στο όνοµα του στοιχείου, όπως File.  

 

2. Κάνουµε κλικ στην εντολή που θέλουµε από το συγκεκριµένο µενού, 

όπως New ή πατάµε το γράµµα που συνδέεται µε αυτή την εντολή, N για το 

New). 

 

3 Αν η εντολή απαιτεί να δηλώσουµε κάποιες επιπλέον πληροφορίες, 

τότε το Minitab ανοίγει ένα πλαίσιο διαλόγου, διαφορετικά εκτελεί την εντολή 

άµεσα. 

Παρακάτω, στην παράγραφο  Περιγραφική Στατιστική, θα δούµε αναλυτικά 

τη χρήση εντολών για την Περιγραφική στατιστική µεταβλητών.  

 

 

Session και worksheet window 

Στο παράθυρο του Minitab εµφανίζονται δύο βασικά παράθυρα: 



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0                       3/ III                    Ευγενία Τσοµπανάκη 

 το Session window, όπου εµφανίζονται οι εντολές και τα 

αποτελέσµατα. Στο παράθυρο αυτό µπορούµε να παρέµβουµε 

γράφοντας κάποιες σηµειώσεις ή διαγράφοντας κάποια αποτελέσµατα 

και 

 το Data window ή worksheet, όπου εισάγουµε, βλέπουµε και 

επεξεργαζόµαστε τα δεδοµένα.  

 

Αρχικά το worksheet είναι άδειο. Κάθε γραµµή των δεδοµένων θα περιέχει 

στοιχεία-δεδοµένα για ένα συγκεκριµένο άτοµο / αντικείµενο. Κάθε στήλη (C1, 

C2,…) αντιστοιχεί σε µία µεταβλητή. 

 

Τα κελιά κάτω από τους τίτλους των στηλών (C1, C2, C3, ...) 

 
είναι για τη λεκτική περιγραφή- ονοµασία των µεταβλητών, δεν πρέπει να 

εισάγουµε δεδοµένα.  

  

Graph window 

Ένα επιπλέον παράθυρο του Minitab είναι το Graph window, το οποίο 

περιέχει γράφηµα των δεδοµένων. 

 

Στο Minitab υπάρχει µόνο ένα Session window ενώ µπορούν να εµφανιστούν 

πολλά Data και Graph windows. Παρότι πολλά παράθυρα µπορεί να είναι 

ορατά ταυτόχρονα, µόνο ένα παράθυρο είναι ενεργό. Στο παράθυρο που 

είναι ενεργό η µπάρα που περιέχει τον τίτλο του είναι φωτισµένη.   
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 Ενεργοποίηση παραθύρου 

 
 
Για να κάνουµε ένα παράθυρο ενεργό απλά κάνουµε κλικ µε το ποντίκι επάνω 
του. Μπορούµε επίσης να ενεργοποιήσουµε ένα παράθυρο κάνοντας κλικ στο 
κατάλληλο εικονίδιο του toolbar.  
 

   
 

 
Ένας τρίτος τρόπος είναι χρησιµοποιώντας κυλιόµενο menu κάτω από την εντολή 
Window.  
 

 
 
 
Το σύµβολο √ µπροστά από το όνοµα δηλώνει ποιό παράθυρο είναι ενεργό. 
Κάνοντας κλικ σε οποιοδήποτε από τα παράθυρα µπορούµε να το 
ενεργοποιήσουµε. 
 

 Μεγιστοποίηση και ελαχιστοποίηση παραθύρου 

Με τα τρία αυτά κουµπιά   τα  οποία εµφανίζονται στην άκρη δεξιά 

από κάθε παράθυρο ελέγχουµε το µέγεθος του παραθύρου. Το πρώτο 

κουµπί ελαχιστοποιεί το παράθυρο, ώστε να µην είναι πλέον ορατό. Το 

παράθυρο µπορεί να γίνει πάλι ορατό µέσω της εντολής Windows και της  

διαδικασίας που περιγράφηκε στην ενεργοποίηση παραθύρου . Το µεσαίο 
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µας δίνει τη δυνατότητα εναλλαγής µεταξύ µεγιστοποίησης ενός παραθύρου 

και επαναφοράς του στο ενδιάµεσο µέγεθος. Το δεξί κουµπί κλείνει ένα 

παράθυρο. Αν το περιεχόµενο του παραθύρου δεν έχει αποθηκευθεί τότε 

αυτό χάνεται. 

 

Το ίδιο σετ κουµπιών υπάρχει και στην κορυφή της οθόνης τα 

οποία αντιστοιχούν στις ίδιες λειτουργίες για το πρόγραµµα Minitab. 

 
 

 Εισαγωγή δεδοµένων 

Το Minitab δίνει τη δυνατότητα να εισάγουµε δεδοµένα µε αρκετούς τρόπους 

όπως:  

1. Πληκτρολογώντας δεδοµένα κατευθείαν στο data window 

2. Με αντιγραφή και επικόλληση 

3.  Άνοιγµα δεδοµένων από ένα αρχείο.  

Πληκτρολόγηση 

 

Για να εισάγουµε δεδοµένα σε ένα φύλο εργασίας δεδοµένων του Minitab θα 

πρέπει να ανοίξουµε ένα κενό φύλο εργασίας δεδοµένων επιλέγοντας 

File/New και από το παράθυρο διαλόγου  

 
να επιλέξουµε Minitab Worksheet. 

 

Για να καταχωρήσουµε δεδοµένα σε στήλες θα πρέπει το βέλος 
κατεύθυνσης δεδοµένων που εµφανίζεται στο αριστερό πεδίο πριν τα 

ονόµατα των στηλών να έχει κατεύθυνση προς τα κάτω ενώ αν θέλουµε να 

εισάγουµε δεδοµένα σε γραµµές θα πρέπει να έχει κατεύθυνση προς τα 
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δεξιά. Τα δεδοµένα εισάγονται µε πληκτρολόγηση και πάτηµα του πλήκτρου 

Tab ή Enter. 

  

 

Εισαγωγή κατά γραµµές 

Εισαγωγή κατά στήλες  

 

Πατώντας Ctrl+Enter µετακινούµε το ενεργό κελί στην κορυφή της επόµενης 

στήλης ή γραµµής ανάλογα µε την κατεύθυνση του βέλους κατεύθυνσης 

δεδοµένων. 

 

Παράδειγµα εισαγωγής δεδοµένων 
 

∆εκατέσσερις άνθρωποι ρωτήθηκαν πόσο κοστίζει το ακριβότερο τους 

ζευγάρι παπούτσια ενώ καταγράφηκε και το φύλο κάθε ατόµου καθώς και το 

πόσα ζευγάρια παπούτσια αγόρασαν την προηγούµενη χρονιά, όπως 

φαίνεται παρακάτω.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Νο Κόστος Φύλο Πλήθος Νο Κόστος Φύλο Πλήθος 

1 70 Γυναίκα 2 7 70 Γυναίκα 3 

2 80 Γυναίκα 4 8 150 Άνδρας 1 

3 90 Γυναίκα 2 9 45 Γυναίκα 4 

4 85 Άνδρας 5 10 70 Άνδρας 6 

5 30 Γυναίκα 2 11 110 Άνδρας 3 

6 65 Γυναίκα 4 12 85 Άνδρας 3 

7 70 Γυναίκα 3 13 85 Άνδρας 2 

8 150 Άνδρας 1 14 80 Άνδρας 2 

Βέλος 
Κατεύθυνσης 
δεδοµένων 



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0                       7/ III                    Ευγενία Τσοµπανάκη 

 

Εισάγουµε τα στοιχεία στο παράθυρο στοιχείων Minitab. Κάνουµε κλικ στο 

πρώτο κενό κελί κάτω ακριβώς από τη από τη στήλη C1 και πληκτρολογούµε 

σε αυτό το διάστηµα τη λέξη kostos (χρήση greeklish). Πληκτρολογούµε 

επίσης τη λέξη sex (φύλο) ως τίτλο για τη στήλη C2.  

 

↓ C1 C2-T C3 
 Κόστος Φύλο No 

1 70 F 2 

2 80 F 4 

3 90 F 2 

4 85 M 5 

5 30 F 2 

6 65 F 4 

7 70 F 3 

8 150 M 1 

9 45 F 4 

10 70 M 6 

11 110 M 3 

12 85 M 3 

13 85 M 2 

14 80 M 2 

 

Κατόπιν εισάγουµε τις τιµές των στοιχείων όπως µας δόθηκαν. Μπορούµε να 

κινηθούµε από κελί σε κελί µέσα στο παράθυρο στοιχείων µε τη 

χρησιµοποίηση του ποντικιού ή µε τη χρησιµοποίηση των βελών στο 

πληκτρολόγιό µας. Σηµειώστε ότι η "C2" αλλάζει "στο C2-Τ" όταν αρχίζουµε 

να εισάγουµε τα στοιχεία για το φύλο. Αυτό σηµαίνει ότι το Minitab θεωρεί το 

φύλο µια µεταβλητή "κειµένου" ("κατηγορική" ή "ποιοτική"), παρά µια 

ποσοτική µεταβλητή.  

Παρατηρούµε τη µορφή των στοιχείων. Κάθε σειρά περιέχει όλες τις 

πληροφορίες για ένα άτοµο και κάθε στήλη αντιπροσωπεύει την πληροφορία 

(ή τη µεταβλητή) που έχει καταγραφεί. Αυτή είναι η συνηθισµένη µορφή που 

χρησιµοποιείται για όλους τους τύπους στατιστικών αναλύσεων. 

 

Αντιγραφή-επικόλληση 

Το Minitab επιτρέπει: 
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 Αντιγραφή δεδοµένων από ένα άλλο πρόγραµµα χρήσης 

φύλλων εργασίας, όπως  as Lotus1-2-3 or Microsoft Excel και 

επικόλληση στο φύλο εργασίας του Minitab .  

 Αντιγραφή δεδοµένων από έναν πίνακα του επεξεργαστή 

κειµένου Word και επικόλληση στο φύλο εργασίας του Minitab .   

 Αντιγραφή δεδοµένων από ένα φύλο εργασίας του Minitab και 

επικόλληση σε ένα άλλο φύλο εργασίας του Minitab.  

 Αντιγραφή δεδοµένων από το Session window του Minitab 

επικόλληση στο Data window του Minitab 

 

Για να γίνει η αντιγραφή και επικόλληση αρκεί να ακολουθηθούν τα έξης 

βήµατα: 

1. Μαρκάρουµε  τα δεδοµένα.  
2. Επιλέγουµε Edit από το  menu bar και µετά Copy Cells.  
3. Κάνουµε κλικ στο Minitab Data window  
4. Επιλέγουµε ένα από τα ακόλουθα:  

o Για να εισάγουµε δεδοµένα στο ίδιο worksheet κάνουµε κλικ στο 
κελί από όπου θέλουµε να ξεκινά η επικόλληση , επιλέγουµε 
Edit και µετά Paste/Insert Cells.  

o Για να αντικαταστήσουµε δεδοµένα στο τρέχον worksheet 
µαρκάρουµε τα κελιά µε τα δεδοµένα που θέλουµε να 
αντικατασταθούν, επιλέγουµε Edit και µετά Paste Cells.  

 

Άνοιγµα ∆εδοµένων από αρχείο 

Εισαγωγή αρχείου Minitab 
 

Μπορούµε να ανοίξουµε ένα υπάρχον φύλλο εργασίας δεδοµένων του 

Minitab επιλέγοντας File>Open Worksheet και εντοπίζοντας µέσω ενός 

πλαισίου διαλόγου το φάκελο που είναι αποθηκευµένο το αρχείο.  
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Τα φύλλα εργασίας δεδοµένων του Minitab έχουν κατάληξη “.MTB”. 

 

Μπορούµε να ανοίξουµε διάφορους τύπους αρχείων µε την κατάλληλη 

επιλογή του τύπου αρχείου στο πλαίσιο των αρχείων καταλόγων (δείτε το 

πλαίσιο διαλόγου) 

 

 
 

Εισαγωγή φύλλου εργασίας δεδοµένων του Excel 
 

Μπορούµε να ανοίξουµε ένα φύλλο εργασίας δεδοµένων του Excel 

ακολουθώντας τα παρακάτω βήµατα.  
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Στο πλαίσιο διαλόγου Files of Type επιλέγουµε ως τύπο αρχείου που θέλουµε 

να ανοίξουµε Excel 
 

 
 

Στη συνέχεια προσδιορίζουµε τη θέση του αρχείου µέσω του πλαισίου 

διαλόγου Look in , 

 
 

Αφότου εντοπίσουµε τη θέση όπου βρίσκεται το αρχείο προχωρούµε 

κάνοντας χρήση της καρτέλας Preview  
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µέσω της οποίας  µπορούµε να έχουµε µία εικόνα για τη µορφή των 

δεδοµένων που επιθυµούµε να εισάγουµε1.  

 

Μέσω της επισκόπηση του αρχείου αντλούµε πληροφορίες τις οποίες θα 

πρέπει να συµπληρώσουµε στις κατάλληλες θέσεις για να γίνει η οµαλή 

εισαγωγή των δεδοµένων. 

 

Παράδειγµα εισαγωγής αρχείου Excel 
 

Θεωρούµε ότι οι πληροφορίες που µας δόθηκαν στο προηγούµενο 

παράδειγµα σχετικά µε την αγορά παπουτσιών έχουν αποθηκευθεί σε ένα 

φύλο εργασίας Excel µε την ονοµασία MIINITAB_4.xls.  

 

                                            
1 Θα πρέπει εδώ να σηµειωθεί ότι η έκδοση MINITAB 12 επιτρέπει την εισαγωγή φύλου δεδοµένων Excel µόνο της 

έκδοσης 4.0. Για το λόγο αυτό θα πρέπει να προηγηθεί η µετατροπή του φύλου δεδοµένων Excel από οποιαδήποτε 

µεταγενέστερη έκδοση σε έκδοση Excel  4.0. 
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Μέσω της προεπισκόπησης παρατηρούµε ότι κατά την ανάγνωση των 

δεδοµένων το Minitab αναγνωρίζει ότι υπάρχουν 3 στήλες δεδοµένων, C1- 

C2-C3, δηλώνοντας τα ονόµατα των µεταβλητών όπως έχουν καθοριστεί, οι 

τιµές των δεδοµένων ξεκινούν στη Γραµµή 2. Επίσης αναγνωρίζει σωστά τον 

τύπο των µεταβλητών καθώς παρατηρούµε ότι δηλώνει ως text τον τύπο της 

µεταβλητής Filo που βρίσκεται στη στήλη 3 καθώς περιέχει χαρακτήρες και 

όχι αριθµητικές τιµές. 

Η εισαγωγή του αρχείου αυτού µπορεί να γίνει άµεσα αφότου βγούµε από το 

παράθυρο της προεπισκόπησης, µε χρήση της εντολής Open. 

Σε περίπτωση που κατά την προεπισκόπηση δεν έχει γίνει σωστή ανάγνωση 

του αρχείου, τότε µέσω της καρτέλας Options η οποία βρίσκεται ακριβώς 

δίπλα στο Preview, µπορούµε να κάνουµε τις κατάλληλες τροποποιήσεις και 

µετέπειτα να προχωρήσουµε στο άνοιγµα του αρχείου. 

 

Αν για παράδειγµα η πρώτη γραµµή του φύλου εργασίας του αρχείου Excel 

είναι κενή , όπως στο Minitab_41.xls, τότε η ανάγνωση του αρχείου δεν 

γίνεται ορθά. 
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Παρατηρώντας τη δοµή του αρχείου, στην καρτέλα Options προχωρούµε ως 

εξής 

o Στο πεδίο Variable Names ,κάνουµε χρήση της επιλογής να δηλώσουµε 

εµείς από ποια γραµµή θα γίνει η ανάγνωση των ονοµάτων των 

µεταβλητών ( Row 2) 

o Στο πεδίο First Row of Data , κάνουµε χρήση της επιλογής να 

δηλώσουµε εµείς από ποια γραµµή θα γίνει η ανάγνωση των δεδοµένων 

( Row 3) 

Αφότου κλείσουµε την καρτέλα Options µπορούµε είτε να επαναλάβουµε 

την προεπισκόπηση για να βεβαιωθούµε για την ορθή ανάγνωση του 

αρχείου είτε να προχωρήσουµε στην άµεση ανάγνωση του αρχείου µέσω 

της εντολής Open. 
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Οι υπόλοιπες επιλογές της καρτέλας Options αποτελούν χρήσιµες 

δυνατότητες για την εισαγωγή δεδοµένων µε συγκεκριµένη µορφή όπως στην 

εισαγωγή αρχείου µορφής ASCII (κείµενο) που θα δούµε παρακάτω. 

 

Eισαγωγή αρχείου ASCII (κείµενο) 
 

Μπορούµε να επιλέξουµε να ανοίξουµε ένα αρχείο στοιχείων ASCII 

(κείµενο) επιλέγοντας µία από τις παρακάτω δύο διαδικασίες: 

 

o File>Other Files>Import Special Text.  

 

Με τον τρόπο αυτό µπορεί να εισαχθεί ένα αρχείο  

a. το οποίο έχει σχηµατοποιηθεί µε κάποιο ιδιαίτερο τρόπο 

(special format). 

b. να επισυνάπτουν τα στοιχεία από ένα αρχείο στο κατώτατο 

σηµείο των υπαρχουσών στηλών.  

c.  

 

o File > Open Worksheet (ή File) και κατάλληλη χρήση της καρτέλας 

Options 
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Με το File > Open Worksheet (ή File) τα στοιχεία τοποθετούνται σε ένα νέο 

φύλλο εργασίας, ή, όταν χρησιµοποιείται την επιλογή συγχώνευσης (Merge), 

τοποθετούνται σε νέες στήλες στο τρέχον φύλλο εργασίας. 

 

Παράδειγµα εισαγωγής αρχείου ASCII (κείµενο) 
 

 Με χρήση της επιλογής File>Other Files>Import Special Text.  

 

Θεωρούµε ότι οι πληροφορίες που µας δόθηκαν σε προηγούµενο 

παράδειγµα σχετικά µε την αγορά παπουτσιών έχουν αποθηκευθεί σε ένα 

αρχείο κειµένου µε την ονοµασία MIINITAB_4tab.txt, όπου οι µεταβλητές 

χωρίζονται από το σύµβολο της παραγράφου . 

 

 
 

Για να γίνει ορθά η ανάγνωση του αρχείου δίνουµε τις στήλες που θα 

εισαχθούν τα δεδοµένα, C1 C2 C3 ή τα ονόµατά τους και στην καρτέλα 

Format δηλώνουµε ότι η µορφή των δεδοµένων καθορίζεται ως : 

 

o Tab delimited (οι στήλες χωρίζονται από την παράγραφο) 

o Τα ονόµατα των στηλών βρίσκονται στην 1η γραµµή  
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 Με χρήση της επιλογής File > Open Worksheet (ή File) 

 

Θεωρούµε ότι οι πληροφορίες που µας δόθηκαν σε προηγούµενο 

παράδειγµα σχετικά µε την αγορά παπουτσιών έχουν αποθηκευθεί σε ένα 

αρχείο κειµένου µε την ονοµασία MIINITAB_4.txt.  

Παρατηρούµε ότι στο πάνω µέρος του κειµένου αναφέρονται κάποιες 

πληροφορίες για το κείµενο, ενώ οι µεταβλητές χωρίζονται από το σύµβολο #. 
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Για να γίνει ορθά η ανάγνωση του αρχείου στην καρτέλα Options κάνουµε τις 

εξής ρυθµίσεις: 

 

  

o Στο πεδίο Variable Names ,κάνουµε χρήση της επιλογής να δηλώσουµε 

εµείς από ποια γραµµή θα γίνει η ανάγνωση των ονοµάτων των 

µεταβλητών ( Row 3) 
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o Στο πεδίο First Row of Data , κάνουµε χρήση της επιλογής να 

δηλώσουµε εµείς από ποια γραµµή θα γίνει η ανάγνωση των δεδοµένων 

( Row 4) 

o Στο πεδίο Single character separator , κάνουµε χρήση της επιλογής να 

δηλώσουµε εµείς το σύµβολο που χωρίζει τις στήλες των δεδοµένων( #) 

 

 

 Έλεγχος στοιχείων/Αρχείου 

 

Ένας τρόπος να ελέγξουµε τα στοιχεία µας είναι µεγιστοποιώντας το 

παράθυρο πληροφοριών . 

Θα πρέπει να σηµειώσουµε ότι µπορούµε να αποθηκεύσουµε το παράθυρο 

πληροφοριών Info επιλέγοντας File/Save Info Window As . 
 

Επίσης χρήσιµη είναι η δυνατότητα συνοπτικής περιγραφής του αρχείου 

δεδοµένων, µέσω της επιλογής Editor/Worksheet Description. 

 

 
 

Η περιγραφή του αρχείου δεδοµένων µπορεί να γίνει και κατά την 

αποθήκευση του αρχείου, όπως θα δούµε στην ενότητα Αποθήκευση. 
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 ∆ηµιουργία µεταβλητών 

 

Μπορούµε να δηµιουργήσουµε ή να µετασχηµατίσουµε µεταβλητές στο 

Minitab µέσω της επιλογής Calk. 

 

Αν για τα δεδοµένα της αγοράς παπουτσιών υποθέσουµε ότι την επόµενη 

χρονιά υπάρχει µία αύξηση της τιµής των παπουτσιών κατά 10%, τότε στη 

µεταβλητή MulKostos εµφανίζονται οι υπολογισµένες µέσω της σχέσης 

MultKostos=Kostos+Kostos*10/100, οι νέες τιµές 

 

 

 Χειρισµός µεταβλητών 

Αλλαγή τύπου 

 

Μπορούµε να αλλάξουµε τους τύπους µεταβλητών µέσω των ακόλουθων 

µετασχηµατισµών, εφόσον αυτό έχει έννοια. 
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∆εν έχει νόηµα να προσπαθήσουµε να αλλάξουµε µία µεταβλητή η οποία 

περιέχει ονόµατα ανθρώπων σε αριθµητικές τιµές. Θα µπορούσαµε όµως να 

είχαµε µία µεταβλητή µε αριθµούς η οποία κατά λάθος εισήχθη ως κείµενο και 

µε τον κατάλληλο χειρισµό να την ορίσουµε ως αριθµητική. 

 

Κωδικοποίηση 

 

Ανάλυση σε οποιοδήποτε αρχείο δεδοµένων µπορεί να γίνει µόνο αν τα 

στοιχεία έχουν δηλωθεί στο αρχείο µε τη µορφή αριθµών (τιµές ή κωδικοί). 

Στο παράδειγµα µας δεν είναι δυνατόν να πάρουµε κάποια πληροφορία για 

τη µεταβλητή φύλο των αγοραστών αν αυτή απλά παραµείνει ως Filo µε τιµές 

F για τις γυναίκες και M για τους άνδρες. 

Για το λόγο αυτό θα πρέπει να δηµιουργήσουµε µία µεταβλητή , ας πούµε τη 

µεταβλητή Sex κάνοντας την ακόλουθη αντιστοίχηση 

 

Τιµή Κωδικός 

F 0 

M 1 
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 Επιλογή δεδοµένων 

Είναι δυνατό κάποιες φορές να θέλουµε να προχωρήσουµε στην ανάλυση 

µόνο κάποιων από τα στοιχεία ενός συνόλου δεδοµένων τα οποία 

ικανοποιούν µία συγκεκριµένη συνθήκη. Για παράδειγµα θα θέλαµε ανάλυση 

µόνο για τις γυναίκες φοιτήτριες ή για τους φοιτητές οι οποίοι ανήκουν σε µία 

συγκεκριµένη ηλικιακή ή οικονοµική τάξη. 

Για να γίνει αυτό αφού ενεργοποιήσουµε το Data window στο οποίο θέλουµε 

να κάνουµε την επιλογή επιλέγουµε Manip <Subset Worksheet 

Στο παράθυρο διαλόγου που ανοίγει προσδιορίζουµε στην επιλογή  Condition 
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τις τιµές στις οποίες θέλουµε να εστιάσουµε την προσοχή µας.  

Στο δικό µας παράδειγµα έστω ότι θέλουµε να συλλέξουµε πληροφορίες µόνο 

για τα παπούτσια τα οποία κοστίζουν λιγότερο από 100euro. Για το λόγο αυτό 

ορίζουµε ως συνθήκη Kostos <=100. 

 

 
  

Με αυτή τη διαδικασία δηµιουργούµε το παρακάτω υποσύνολο των αρχικών 

δεδοµένων  σύµφωνα µε τη συνθήκη που θέσαµε. 
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 Στατιστική Ανάλυση 

Αρχικά θα ασχοληθούµε µε βασική στατιστική ανάλυση των στοιχείων. Η 

έµφαση δίνεται στη χρήση στου στατιστικού πακέτου για την απόκτηση των 

αποτελεσµάτων και όχι στην ερµηνεία των εννοιών.  

Για να προβούµε σε βασική στατιστική ανάλυση, κάνουµε κλικ στη λέξη STAT 

στο µενού εντολών.  

Περιγραφική στατιστική 

Στο κυλιόµενο µενού επιλέγουµε Basic Statistics, και έπειτα Display 

Descriptive Statistics  (Στο µέλλον, µια τέτοια ακολουθία επιλογών θα 

δηλώνουµε ως Stat > Basic Statistics > Display Descriptive Statistics. 

 

 
 

Οι επιλογές µας αυτές θα µας δώσουν ένα παράθυρο περιγραφικών 

στατιστικών µε το δροµέα να αναβοσβήνει στο ορθογώνιο πλαίσιο των 

µεταβλητών.  
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Παρατηρούµε ότι µόνο οι µεταβλητές µε αριθµητικές τιµές εµφανίζονται ( η 

µεταβλητή χαρακτήρων Filo δεν εµφανίζεται). Μεταφέρουµε τη µεταβλητή/ες 

που επιθυµούµε να αναλύσουµε στο δεξί ορθογώνιο πλαίσιο των 

µεταβλητών. Ο ευκολότερος τρόπος να γίνει αυτό είναι να κάνουµε δύο φορές 

κλικ στη µεταβλητή kostos στο αριστερό πλαίσιο. Εάν αυτό γίνει, η µεταβλητή 

kostos θα εµφανιστεί τώρα και στο ορθογώνιο πλαίσιο των µεταβλητών. 

(Μπορούµε να πληκτρολογήσουµε απλά τη λέξη kostos εκεί όπου 

αναβοσβήνει ο δροµέας αλλά ο τρόπος αυτός δεν συνιστάται.) ∆ιαφορετικά 

µπορούµε απλά να επιλέξουµε τη µεταβλητή kostos κάνοντας κλικ επάνω της 

και κατόπιν να πατήσουµε το κουµπί Select στο παράθυρο επιλογών. 

 

Στο παράθυρο αυτό επιλογών δίνεται η δυνατότητα να ζητήσουµε και 

γραφήµατα για τις µεταβλητές µέσω της επιλογής Graph. Τη διαδικασία 

δηµιουργίας γραφηµάτων θα τη δούµε παρακάτω. Πατώντας OK, στο 

Session Window, είναι τα στατιστικά αποτελέσµατα.  

 

Descriptive Statistics 
 
 
Variable   N       Mean     Median     TrMean      StDev    SE Mean 
Kostos    12      80,42      82,50      78,50      30,34       8,76 
 
Variable  Minimum    Maximum         Q1         Q3 
Kostos    30,00     150,00      66,25      88,75 

 

Παράθυρο εµφάνισης 

όλων των µεταβλητών 

του αρχείου 
Παράθυρο 

επιλεγµένων για 

ανάλυση µεταβλητών 

Επιλογή για να µας 

δοθεί η δυνατότητα 

εµφάνισης 

αποτελεσµάτων 

χωριστά για κάθε τιµή

της µεταβλητής που 

θα δηλωθεί στο 

παράθυρο 
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Αν είχε ζητηθεί η επιλογή , τότε θα µας 

είχε δοθεί όλη η παραπάνω πληροφορία αναλυτικά για τις δύο τιµές της 

µεταβλητής sex: 

 

Descriptive Statistics 
 
 
Variable   Sex         N       Mean     Median     TrMean      StDev 
Kostos     0           5       60,0       65,0       60,0       23,2 
           1           7       95,0       85,0       95,0       27,1 
 
Variable   Sex   SE Mean    Minimum    Maximum         Q1         Q3 
Kostos     0       10,4       30,0       90,0       37,5       80,0 
           1       10,2       70,0      150,0       80,0      110,0 

Κατανοµή συχνοτήτων 

Στο κυλιόµενο µενού επιλέγουµε  

 

 
 

Μέσω αυτής της εντολής µπορούµε να ζητήσουµε από το Minitab να µας 

υπολογίσει συχνότητα, αθροιστική συχνότητα, σχετική συχνότητα και 

αθροιστική σχετική συχνότητα ∆ιακριτών µεταβλητών. 

 

Η επιλογή µας αυτή µας µεταφέρει  στο παρακάτω πλαίσιο διαλόγου: 
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Κάνοντας διπλό κλικ µεταφέρουµε τη µεταβλητή Sex στο δεξί παράθυρο για 

τις προς ανάλυση µεταβλητές. Επιλέγοντας όλα τα αποτελέσµατα που 

µπορούν µέσω αυτού του παραθύρου να µας δοθούν, ένα √ στο κουτί κάθε 

επιλογής δηλώνει ότι έχει γίνει η επιλογή, έχουµε το παρακάτω αποτέλεσµα 

στο Session window: 

 

Summary Statistics for Discrete Variables 
  
 

 Sex   Count  CumCnt   Percent  CumPct 
       0       5      5      41,67   41,67 
       1       7      12     58,33  100,00 
      N=      12 
 

Η 1η στήλη απλά παρουσιάζει όλες τις τιµές της µεταβλητής Sex, η 2η στήλη 

δίνει τη συχνότητα αντίστοιχα για κάθε τιµή της µεταβλητής, η 3η στήλη την 

αθροιστική συχνότητα , η 4η στήλη τη σχετική συχνότητα ως ποσοστό και 

η τελευταία στήλη τη σχετική αθροιστική συχνότητα ως ποσοστό για τις 

τιµές της µεταβλητής. 

 

Μπορούµε µέσω τις διαδικασίας αντιγραφής- επικόλλησης να µεταφέρουµε 

αυτή την πληροφορία σε ένα νέο φύλλο εργασίας του Minitab, ώστε να 

δηµιουργήσουµε τα απαραίτητα γραφήµατα.  
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Για να γίνει αυτό κάνουµε ενεργό το Session κάνοντας κλικ επάνω του. Με 

χρήση του ποντικιού µαρκάρουµε τις δύο γραµµές αποτελεσµάτων  
 

     0      5      5    41,67  41,67 

         1      7     12    58,33 100,00 

 

επιλέγουµε Edit> Copy. Για να µεταφέρουµε τα δεδοµένα αυτά σε ένα νέο 

φύλλο εργασίας, επιλέγουµε File>New και εµφανίζεται το πλαίσιο διαλόγου  

 

 
 
Επιλέγουµε Minitab Worksheet και πατάµε OK. Έτσι δηµιουργείτε ένα νέο 

φύλλο εργασίας µε τις αντίστοιχες στήλες (τα ονόµατα των στηλών έχουν  

προστεθεί µετά την επικόλληση). 

 

 

 

 Γραφική παράσταση δεδοµένων 

Το Minitab µας δίνει τη δυνατότητα δηµιουργίας διάφορων τύπων 

γραφηµάτων είτε άµεσα µέσω της εντολής Graph και την κατάλληλη επιλογή 

από το κυλιόµενο παράθυρο ή ως επιλογή µέσω των εντολών ανάλυσης και 

τα παράθυρα διαλόγου. 

 



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0                       28/ III                    Ευγενία Τσοµπανάκη 

 Bar graph 

 

Για να δηµιουργήσουµε ένα ραβδόγραµµα επιλέγουµε Graph < Chart και 

εµφανίζεται το ακόλουθο παράθυρο 

 
 

Για το παράδειγµά µας θα θέλαµε να δηµιουργήσουµε ένα ραβδόγραµµα της 

µεταβλητής sex, για την οποία σε προηγούµενη ενότητα παρουσιάσαµε πως 

µπορούµε να αποθηκεύσουµε την κατανοµή συχνοτήτων της (βλ. Κατανοµή 

συχνοτήτων).  

Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα: 
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 Frequency polygon 

 

Για να δηµιουργήσουµε ένα πολύγωνο συχνοτήτων επιλέγουµε Graph < Plot 

και εµφανίζεται το ακόλουθο παράθυρο  

 

 
 

όπου συµπληρώνουµε στο πεδίο της Y µεταβλητής τη συχνότητα που έχουµε 

υπολογίσει και αποθηκεύσει για τη µεταβλητή no, την οποία στο πεδίο X 

αναφέρουµε ως number.Το γράφηµα που προκύπτει είναι: 

 

 



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0                       30/ III                    Ευγενία Τσοµπανάκη 

 Pie chart 

Για να δηµιουργήσουµε ένα κυκλικό γράφηµα, επιλέγουµε Graph < Pie Chart 

και εµφανίζεται το ακόλουθο παράθυρο  

 

 
 

Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα: 

1 (1; 50,0%)

0 (1; 50,0%)

Pie Chart of Sex
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 Histogram 

Για να δηµιουργήσουµε ένα ιστόγραµµα, επιλέγουµε Graph < Histogram και 

εµφανίζεται το ακόλουθο παράθυρο  

 

 
 

Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα: 
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 Stem and Leaf 

Για να δηµιουργήσουµε ένα διάγραµµα µίσχου -φύλλου, επιλέγουµε Graph < 

Stem and Leaf και εµφανίζεται το ακόλουθο παράθυρο  

 

 
 

Συµπληρώνουµε τα πεδία όπως φαίνεται στο παράθυρο και δηµιουργείται το 

παρακάτω γράφηµα στο παράθυρο του Session 

: 
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 Επεξεργασία γραφηµάτων 

 

Μετά την παραγωγή γραφήµατος και την εµφάνισή του στην οθόνη µας, 

πιθανόν να θέλουµε να παρέµβουµε κάνοντας κάποιες τροποποιήσεις. Για να 

γίνει αυτό κάνουµε διπλό κλικ στο γράφηµα και ενεργοποιούνται δύο παλέτες 

επιλογών, η παλέτα εργαλείων Tool Palette η οποία είναι στην κορυφή και η 

παλέτα χαρακτηριστικών Attribute palette.  
 

 
 

1. Για να τροποποιήσουµε ας πούµε τον τίτλο του γραφήµατος  

• κάνουµε διπλό κλικ στον τίτλο και εµφανίζεται ένα µικρό παράθυρο 

όπου δακτυλογραφούµε το κείµενο 
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Για να τροποποιήσουµε τη γραµµατοσειρά του τίτλου του γραφήµατος 

κάνουµε κλικ στον τίτλο και εµφανίζεται ένα µικρό κουτί τετραγώνων. Στην 

παλέτα χαρακτηριστικών επιλέγουµε  

o µία γραµµατοσειρά ελληνικών Times new Roman Greek 

o χρώµα για τον τίτλο 

o µέγεθος γραµµατοσειράς 

 
 

 

Μπορούµε έπειτα να σύρουµε τον τίτλο για να βάλουµε το κείµενο στην 

επιθυµητή θέση. Μετά τις αλλαγές έχουµε το Γράφηµα 1 . 
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Ιστόγραµµα Κόστους
 

Γράφηµα 1 Ιστόγραµµα του Κόστους των Υποδηµάτων 

 

Προκειµένου να τεθεί η γραφική παράστασή µας σε ένα έγγραφο του 

Microsoft Word θα πρέπει αρχικά να κάνουµε ένα αντίγραφο από αυτό. 

Αλλάζω γραµµατοσειρά 

Αλλάζω χρώµα 

Αλλάζω µέγεθος 
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Μπορούµε να το κάνουµε αυτό κάνοντας δεξί κλικ στο γράφηµα και επιλογή 

Copy Graph (αντιγραφή γραφικής παράστασης). Με τον τρόπο αυτό ένα 

αντίγραφο της γραφικής παράστασης αποθηκεύεται στο " clipboard " του 

υπολογιστή µας. Από εκεί µπορεί να επικολληθεί στο έγγραφο εκθέσεών µας-

report.  

 

 
 

 

 Χρήση Εντολών 

 

Οι ίδιες πληροφορίες µπορούν να αποκτηθούν και µε τη χρήση εντολών. Για 

το σκοπό αυτό θα πρέπει στο Session να εµφανίζεται το Minitab prompt 
(MTB>). Η ενεργοποίησή του µπορεί να γίνει επιλέγοντας Editor/Enable 
Command Language.  
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Με τον τρόπο αυτό για κάθε ενέργεια που πραγµατοποιούµε στο Minitab 

µέσω των παραθύρων εµφανίζεται η σύνταξή της αντίστοιχης εντολής στο 

Minitab. Έτσι είναι δυνατή η εκµάθηση βασικών εντολών.  

Για παράδειγµα για να µας δοθούν περιγραφικά µέτρα και το ιστόγραµµα για 

τη µεταβλητή “Κόστος” η σύνταξη των εντολών/υποεντολών είναι: 
 

MTB > Describe 'Kostos'; 
SUBC>GHist. 
 

 

Όπως µπορούµε να παρατηρήσουµε η πρώτη γραµµή εντολών χωρίζεται 

από τη δεύτερη µε το σύµβολο ; Με το σύµβολο αυτό λέµε στο Minitab ότι 

υπάρχουν και άλλα στοιχεία που θα ζητήσουµε µε την εντολή αυτή. 

Με το SUBC> prompt προσδιορίζουµε την υποεντολή για το συγκεκριµένο 

γράφηµα, το ιστόγραµµα της µεταβλητής. Η τελεία . δηλώνει στο Minitab ότι 

έχουµε ολοκληρώσει µε τις εντολές/υποεντολές. 

 

 Ρυθµίσεις 

 

Καλό είναι κάποιες ρυθµίσεις σας να τις “σώζουµε” έτσι ώστε θα είναι σε ισχύ 

κάθε φορά που χρησιµοποιούµε το Minitab.  

Για παράδειγµα για να είναι πάντα ενεργοποιηµένο το Minitab prompt (MTB>) 

επιλέγουµε Edit>Preferences>Session Window και επιλέγουµε Enable 
Command Language, όπως φαίνεται στο παράθυρο. 
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Μπορούµε να αλλάξουµε την προτίµησή µας οποιαδήποτε στιγµή 

ακολουθώντας τα ίδια βήµατα. 

 

 Βοήθεια 

 

Θα πρέπει να τονιστεί ιδιαίτερα ότι είναι πολύ σηµαντική η χρήση της 

βοήθειας Help κάθε προγράµµατος που χρησιµοποιούµε. Το Minitab παρέχει 

σηµαντική βοήθεια σε κάθε επιλεγόµενο παράθυρο. Ας δούµε στο 

συγκεκριµένο µενού επιλογών τη βοήθεια που θα µπορούσαµε να έχουµε για 

παράδειγµα στη χρήση της εντολής Calc: 

 

 

 

 Αποθήκευση 

 

Για να αποθηκεύσουµε τη δουλειά µας στο Minitab υπάρχουν δύο επιλογές  

 

o File > Save Current Worksheet As µε την οποία απλά αποθηκεύουµε 

τα δεδοµένα µας σε ένα αρχείο του Minitab. 

 

Η αποθήκευση του αρχείου µπορεί να συνοδεύεται µε δήλωση και στοιχείων 

για την περιγραφή του αρχείου δεδοµένων, µέσω της επιλογής Description  
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o File > Save Project As, µε την οποία αποθηκεύονται επίσης τα 

γραφήµατα και τα αποτελέσµατα τουSession. 

Μέσω της επιλογής Options µπορούµε να επιλέξουµε τα γραφήµατα, τα 

αποτελέσµατα του Session, οι ρυθµίσεων που έχουµε επιλέξει και το 

παραθύρου History να αποτελούν αποθηκεύονται κάθε φορά που 

αποθηκεύουµε ένα project.  

 

 
 

Υπάρχει η δυνατότητα να αποθηκεύσουµε το αρχείο των δεδοµένων µας και 

ως άλλου τύπου αρχείο µε την κατάλληλη επιλογή του τύπου αρχείου στο 

πλαίσιο των αρχείων καταλόγων (δείτε το πλαίσιο διαλόγου), ώστε να είναι 

δυνατή η άµεση επεξεργασία του µε άλλα προγράµµατα. 
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 Εκτύπωση  

 

Μπορούµε να τυπώσουµε οποιοδήποτε παράθυρο µε τη µετάβαση στις 

επιλογές αρχείων File και την επιλογή της Print. Αυτό ισχύει για Microsoft 

Word, Minitab, και για οποιοδήποτε πρόγραµµα λογισµικού εάν 

χρησιµοποιούµε το λειτουργικό σύστηµα παραθύρων της Microsoft.  
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 Εφαρµογή µε χρήση του Στατιστικού πακέτου 
Minitab 12.0 
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Περιγραφή ∆εδοµένων

Σε µία έρευνα µετρήθηκε η ποσότητα
γλυκόζης (mg%) στο αίµα εκατό
ατόµων για τη διερεύνηση της ύπαρξης
διαβήτη ενώ καταγράφηκε και το φύλο
του ασθενούς
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∆εδοµένα
Α/Α Γλυκόζη (mg%) Φύλο Α/Α Γλυκόζη (mg%) Φύλο Α/Α Γλυκόζη (mg%) Φύλο Α/Α Γλυκόζη (mg%) Φύλο

1 70 Γ 26 101 Α 51 85 Γ 76 102 Α
2 86 Γ 27 103 Γ 52 90 Α 77 106 Α
3 93 Γ 28 106 Α 53 94 Γ 78 107 Α
4 95 Α 29 110 Γ 54 96 Α 79 111 Γ
5 97 Α 30 116 Α 55 98 Α 80 121 Γ
6 101 Γ 31 83 Α 56 101 Γ 81 86 Γ
7 103 Γ 32 88 Γ 57 104 Α 82 92 Α
8 106 Γ 33 93 Α 58 106 Γ 83 94 Α
9 107 Γ 34 96 Γ 59 111 Α 84 97 Α

10 112 Α 35 98 Α 60 116 Γ 85 100 Α
11 79 Γ 36 101 Γ 61 85 Α 86 102 Γ
12 87 Γ 37 104 Γ 62 91 Γ 87 106 Γ
13 93 Α 38 106 Α 63 94 Α 88 107 Γ
14 95 Α 39 111 Α 64 96 Γ 89 112 Α
15 97 Α 40 116 Α 65 98 Γ 90 121 Α
16 101 Α 41 85 Α 66 102 Α 91 86 Γ
17 103 Γ 42 89 Γ 67 105 Α 92 92 Α
18 106 Γ 43 94 Γ 68 106 Γ 93 94 Α
19 108 Γ 44 96 Γ 69 111 Γ 94 97 Γ
20 115 Α 45 98 Α 70 119 Α 95 100 Γ
21 80 Γ 46 101 Α 71 85 Γ 96 103 Α
22 87 Α 47 104 Α 72 91 Α 97 106 Α
23 93 Γ 48 106 Α 73 94 Γ 98 107 Α
24 96 Γ 49 111 Γ 74 97 Γ 99 112 Γ
25 98 Γ 50 116 Γ 75 98 Γ 100 126 Γ
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1. Οργάνωση ∆εδοµένων
Ονόµατα Μεταβλητών

• Ονόµατα µεταβλητών
Πληκτρολογούµε στα πεδία ανάµεσα στο πρώτο κελί
και τα ονόµατα των στηλών
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2. Οργάνωση ∆εδοµένων
Τύπος Μεταβλητών

• ∆ιαµόρφωση
µεταβλητών
– ∆ιαµορφώνουµε τις

µεταβλητές
καθορίζοντας αν
είναι απαραίτητο τον
Τύπο των
µεταβλητών
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3. Οργάνωση ∆εδοµένων
∆εκαδικά Ψηφία

• ∆ιαµόρφωση µεταβλητών

∆ιαµορφώνουµε τις
µεταβλητές καθορίζοντας
τον Αριθµό των
∆εκαδικών ψηφίων

Κάνουµε δεξί κλικ πάνω στη µεταβλητή που θέλουµε να διαµορφώσουµε
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4. Οργάνωση ∆εδοµένων
Missing values

• ∆ιαµόρφωση
µεταβλητών
Καθορίζουµε το
Σύµβολο που θα
παριστάνει πιθανές
ελλιπείς
παρατηρήσεις
(missing values) 
στο αρχείο των
δεδοµένων µας
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5. Οργάνωση ∆εδοµένων
Κωδικοποίηση µεταβλητών

• Κωδικοποίηση µεταβλητών
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Κωδικοποίηση Μεταβλητής Sex

• Female:0
• Male:1

Προσοχή στη χρήση κεφαλαίων & πεζών γραµµάτων
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Οµαδοποίηση Μεταβλητής Glucose

• ≤77   :0  “No diabetes”
• 77-112  :1  “Borderline”
• >112   :2  “Diabetes”

Τα διαστήµατα είναι κλειστά άνω



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0 Ευγενία Τσοµπανάκη50/III

Αρχείο ∆εδοµένων

• Το αρχείο δεδοµένων για τους πρώτους
10 ασθενείς
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Μεταβλητές

• Ποσοτικές -Συνεχείς
Ποσότητα γλυκόζης ~ GlucogeGlucoge

• Ποιοτικά-Κατηγορικά
Φύλο ~SexSex

Χαρακτηρισµός ατόµου~ StatusStatus
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1.1 Ανάλυση ∆εδοµένων “Glucose”

• Μετρήσιµη Μεταβλητή

glucose  Count CumCnt Percent CumPct

70      1      1     1,00   1,00

79      1      2     1,00   2,00

80      1      3     1,00   3,00

83      1      4     1,00   4,00

85      4      8     4,00   8,00

86      3     11     3,00  11,00

87      2     13     2,00  13,00

88      1     14     1,00  14,00

89      1     15     1,00  15,00

90      1     16     1,00  16,00

Κατανοµή Συχνοτήτων ∆ΕΝ έχει νόηµα γι’ αυτό το λόγο οµαδοποιούµε τη
µεταβλητή αυτή στη µεταβλητή status
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1.2 Ανάλυση ∆εδοµένων “Glucose”

• Μετρήσιµη Μεταβλητή

Περιγραφικά Μέτρα
Stat->Basic Statistics->          
Display Descriptive 
Statistics

MTB > Describe  'glucose‘.

Οι εργασίες που κάνω κάνοντας χρήση των µενού µπορούν να γίνουν και
µε χρήση εντολών στο session του Minitab. 

Για να είναι δυνατή η εµφάνιση του Minitab prompt (MTB>) θα πρέπει να
έχει προηγηθεί η ενεργοποίησή του επιλέγοντας Editor/Enable Command 
Language. 
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1.3 Ανάλυση ∆εδοµένων “Glucose”
• Περιγραφικά Μέτρα

Αποτελέσµατα στο Session του Minitab

Variable             N       Mean     Median     TrMean

glucose            100     100,00     100,50     100,00      

StDev SE Mean Minimum 

10,14       1,01 70,00 

Maximum         Q1         Q3

126,00      94,00     106,00

Mean=100 ~~Αθροίζουµε όλες τις τιµές της γλυκόζης και διαιρούµε µε το πλήθος των
ασθενών
Median=100,50~~ Πενήντα παρατηρήσεις βρίσκονται πάνω από την τιµή 100,50 και
πενήντα κάτω
TrMean=100~~ 5% trimmed mean  Αφαιρείται το µικρότερο 5% και το µεγαλύτερο 5% 
των τιµών και υπολογίζεται ο µέση τιµή για τις υπόλοιπες τιµές.
StDev=10.14 mg% Πώς διασπείρονται /σκορπίζονται οι τιµές της γλυκόζης γύρω από τη
µέση τιµή
SE Mean=StDev/Sqrt(n) Μετράει τη µεταβλητότητα του εκτιµητή της µέσης τιµής από
δείγµα σε δείγµα
Q1=94 25% των τιµών είναι µικρότερες από 94 mg% & 75 % των τιµών είναι
µεγαλύτερες από 94 mg% 
Q3=106 75 % των τιµών είναι µικρότερες από 106 mg% & 25 % των τιµών είναι
µεγαλύτερες από 106 mg%
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1.4 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

• Stat->Basic Statistics->         
Display Descriptive Statistics ->Graphs

Το διάγραµµα dot plot που εµφανίζεται µέσω αυτού του µενού δεν είναι
ακριβές. Για το λόγο αυτό θα πρέπει να δηµιουργηθεί το διάγραµµα αυτό
µέσω των επιλογών Γραφηµάτων.
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1.5 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Histogram-Ιστόγραµµα
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1.6 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”
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1.7 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”
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Histogram of glucose

Histogram-Ιστόγραµµα
MTB > Describe 'glucose';

SUBC>  Ghist.

Αν θέλουµε να διατηρήσουµε τις ίδιες κλάσεις µε το διάγραµµα µίσχου
φύλλου, θα πρέπει να δηµιουργήσουµε το ιστόγραµµα από το µενού των
γραφηµάτων.
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1.8 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

70 80 90 100 110 120 130

glucose

Dotplot of glucose

Dot Plot-∆ιάγραµµα Σηµείων

MTB > Describe 'glucose';

SUBC>  Gdotplot.
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1.9 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

120110100908070

glucose

Dotplot for glucose

Dot-Plot 

∆ιάγραµµα Σηµείων

MTB > %Dotplot 'glucose'.

Στο γράφηµα αυτό η θέση κάθε δεδοµένου σε έναν αριθµηµένο άξονα
καθορίζεται µε µία κουκκίδα. Όπου οι τιµές συµπίπτουν οι κουκκίδες
τοποθετούνται η µία πάνω από την άλλη.
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1.10 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

MTB > Stem-and-Leaf 'glucose';
SUBC>   Increment 1.

1    7 0

1    7 
1    7 
1    7 
2    7 9
3    8 0
4    8 3
8    8 5555
13   8 66677
15   8 89
18   9 011
24   9 223333
32   9 44444455
42   9 6666677777
48   9 888888
(8)  10 00111111
44   10 2223333
37   10 4445
33   10 66666666667777
19   10 8
18   11 011111
12   11 222
9   11 5
8   11 6666
4  11 9
3  12 11
1   12 
1   12 
1   12 6

Stem-and-Leaf

∆ιάγραµµα Μίσχου-Φύλλου
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1.11 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

MTB > Stem-and-Leaf 'glucose';
SUBC>   Increment 10.

2    7 09 Η µικρότερη τιµή γλυκόζης είναι 70

15    8 0355556667789
48    9 011223333444444556666677777888888 Μεγαλύτερη συγκέντρωση τιµών

(34) 10 0011111122233334445666666666677778                  µεταξύ 90 και 108
18   11 011111222566669
3    12 116 Η µεγαλύτερη τιµή γλυκόζης είναι 126

Stem-and-Leaf

∆ιάγραµµα Μίσχου-Φύλλου

Αυξάνοντας το “increment” σε 10 δηλώνοντας δηλαδή ότι η διαφορά µεταξύ των
µικρότερων πιθανών τιµών σε δύο διαδοχικές γραµµές είναι µία δεκάδα το διάγραµµα
αλλάζει ως προς τον τρόπο παρουσίασης

Η αριστερή στήλη δηλώνει το σύνολο των τιµών (αθροιστικά) από την κορυφή και προς
τα κάτω & από το τέλος και προς τα πάνω µέχρι τη διάµεσο

Η τιµή σε παρένθεση,(34), µετράει το πλήθος των τιµών στη γραµµή που εµπεριέχει τη
διάµεσο

Στη δεξιά στήλη κάθε ψηφίο (φύλλο) που τοποθετείται δεξιά από το µίσχο
αντιπροσωπεύει µία τιµή των δεδοµένων
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1.12 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Box Plot- ∆ιάγραµµα Πλαισίου Απολήξεων

70 80 90 100 110 120 130

glucose

Boxplot of glucoseMTB > Describe 'glucose';

SUBC>  GBoxplot.
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1.13 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Box Plot- ∆ιάγραµµα Πλαισίου Απολήξεων
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1.14 Ανάλυση ∆εδοµένων Γραφικά
“Glucose”

Βox-Plot ∆ιάγραµµα Σηµείων Απολήξεων
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Ακραία τιµή
Η µεγαλύτερη τιµή
εντός των ορίων
(119)

Η µικρότερη τιµή
εντός των ορίων
(79)

∆ιάµεσος

Το κεντρικό πλαίσιο περιέχει το κεντρικό 50% των δεδοµένων.

Το άνω άκρο του πλαισίου δηλώνει το Q3, ενώ το κάτω άκρο το Q1

Οι απολήξεις δείχνουν τη µέγιστη και ελάχιστη τιµή εκτός αν υπάρχουν ακραίες τιµές

Αν η διάµεσος ισαπέχει από τα άκρα του πλαισίου τότε η κατανοµή των δεδοµένων είναι
συµµετρική

Στο ίδιο συµπέρασµα θα καταλήγαµε συγκρίνοντας τις απολήξεις του πλαισίου.

Γενικά αν η απόληξη του πάνω πλαισίου είναι µεγαλύτερη από αυτή του κάτω, τότε
υπάρχουν περισσότερες µεγάλες τιµές προς το θετικό άκρο της κατανοµής και έτσι η
κατανοµή είναι θετικά ασύµµετρη /λοξή. Αν ισχύει το ακριβώς αντίθετο τότε η κατανοµή
είναι αρνητικά ασύµµετρη /λοξή
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1.15 Ανάλυση ∆εδοµένων “Glucose”
Κατά φύλο

• Περιγραφικά Μέτρα Glucose κατά Φύλο
Stat->Basic Statistics->Display Descriptive Statistics

MTB > Describe  ‘glucose';

SUBC>   By 'sex';
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1.16 Ανάλυση ∆εδοµένων “Glucose”
Κατά φύλο

• Περιγραφικά Μέτρα Glucose κατά Φύλο

Variable   sex               N       Mean     Median     TrMean StDev

glucose    0                48     100,92     101,00     100,82 9,12 

1              52      99,15      99,00      99,22  11,01

Variable   sex         SE Mean    Minimum    Maximum   Q1 Q3

glucose    0           1,32      83,00     121,00   94,00 106,00

1    1,53      70,00     126,00    93,00 106,00
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Ανάλυση ∆εδοµένων
Κατηγορικών Μεταβλητών

• Κατανοµή Συχνοτήτων
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2.1 Ανάλυση ∆εδοµένων “Sex”

• Ονοµαστική Μεταβλητή
Κατανοµή Συχνοτήτων

Οι Αθροιστικές Συχνότητες ∆ΕΝ έχουν
νόηµα για κατηγορικές µεταβλητές

Επικρατούσα
τιµή
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2.2 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

– Bar Chart
Graph->Chart
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2.3 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

– Bar Chart 
Graph->Chart

female male
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52∆ιαθέσιµες Συναρτήσεις για το Γράφηµα

Count number of values (frequency)

N number of non-missing values

Nmiss number of missing values

Mean mean of values

Median median of values

Minimum the smallest value

Maximum the largest value

Stdev standard deviation of values

Ssq sum of squares of values
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2.4 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

– Bar Chart
Graph->Histogram

Για να εµφανίσουµε ποσοστά στο γράφηµα
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2.5 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

• Bar Chart
Graph->Histogram
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2.6 Ανάλυση ∆εδοµένων Γραφικά
“Sex”
• Pie Chart

Graph->Chart



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0 Ευγενία Τσοµπανάκη75/III

2.7 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

• Pie Chart
Graph->Chart
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2.8 Ανάλυση ∆εδοµένων Γραφικά
“Sex”

• Pie Chart
Graph->Chart

Female (48; 48,0%)

Male (52; 52,0%)

Pie Chart of sex

MTB > %Pie 'sex' .



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0 Ευγενία Τσοµπανάκη77/III

3.1 Ανάλυση ∆εδοµένων “Status”

• ∆ιατάξιµη Μεταβλητή
Κατανοµή Συχνοτήτων

88% των ατόµων έχουν τιµές γλυκόζης στο αίµα τους <112 mg%

Η Επικρατούσα Τιµή στη µεταβλητή status είναι 1
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• Pie Chart
Graph->Chart

3.2 Ανάλυση ∆εδοµένων Γραφικά
“Status”

MTB > %Pie 'status'.
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3.3 Ανάλυση ∆εδοµένων Γραφικά
“Status”

MTB > Chart Count( status ) * 'stcode';

SUBC>   Bar;

SUBC>   ScFrame;

SUBC>   ScAnnotation;

SUBC>   Symbol;

SUBC>   Type 0;

SUBC>   Label;

SUBC>   Offset 0,0 0,0125;

SUBC>   Placement 0 1.

•Bar Chart



Εισαγωγή στο Στατιστικό πακέτο Minitab 12.0 Ευγενία Τσοµπανάκη80/III

3.4 Ανάλυση ∆εδοµένων Γραφικά
“Status”

MTB > Histogram 'status';

SUBC>   Cumulative;

SUBC>   Percent;

SUBC>   MidPoint;

SUBC>   Bar;

SUBC>   ScFrame;

SUBC>   ScAnnotation;

SUBC>   Symbol;

SUBC>     Type 0;

SUBC>     Label;

SUBC>     Offset 0,0 0,0125;

SUBC>     Placement 0 1;

SUBC>   Axis 1;

SUBC>   Axis 2.

•Bar Chart
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Ανάλυση ∆εδοµένων

Συµµετρική

Κατανοµή

∆εξιά Λοξή

Κατανοµή

Αριστερά Λοξή

Κατανοµή

•Κατανοµές

Οι δύο κατανοµές διαφέρουν στη συµµετρία. Η κατανοµή στα αριστερά
είναι συµµετρική ενώ η κατανοµή στα δεξιά ασύµµετρη /λοξή. 

Η συµµετρία προσδιορίζεται από τη ουρά µε το µεγαλύτερο
µήκος. 
Αν η ουρά µε το µεγαλύτερο µήκος βρίσκεται προς το µέρος των µεγάλων
αριθµών, τότε η κατανοµή καλείται δεξιά ή θετική λοξή, ενώ στην
αντίθετη περίπτωση καλείται αριστερά ή αρνητικά λοξή.


